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Disclaimer
Thunderhead Engineering makes no warranty, expressed or implied, to users of PetraSim, and accepts
no responsibility for its use. Users of PetraSim assume sole responsibility under Federal law for
determining the appropriateness of its use in any particular application; for any conclusions drawn from
the results of its use; and for any actions taken or not taken as a result of analyses performed using
these tools.
Users are warned that PetraSim is intended for use only by those competent in the field of multi-phase,
multi-component fluid flow in porous and fractured media. PetraSim is intended only to supplement the
informed judgment of the qualified user. The software package is a computer model that may or may
not have predictive capability when applied to a specific set of factual circumstances. Lack of accurate
predictions by the model could lead to erroneous conclusions. All results should be evaluated by an
informed user.
Throughout this document, the mention of computer hardware or commercial software does not
constitute endorsement by Thunderhead Engineering, nor does it indicate that the products are
necessarily those best suited for the intended purpose.
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Setting Multi-Phase, Time Dependent, Essential
(Dirichlet) Boundary Conditions
In this example we demonstrate how to apply time-dependent temperature boundary conditions for
single phase problems. The user should refer to the PetraSim manual and the corresponding multi-phase
example for further discussion.
In this description, we use a thin layer to define the boundary conditions. An alternate is to use “extra
cells”, as illustrated in the multi-phase example. We first illustrate the basic concepts using a simple
cube. We then demonstrate how to apply time-dependent boundary conditions to a more complex
model.

Create a Simple Model
Following the instructions already presented in previous example problems, make a new model using
EOS1 and dimensions of 10x10x10 meters. To define a thin layer on the top of the model:
1.
2.
3.
4.
5.
6.

In the Tree View, expand the Layers node and click Default
On the Edit menu, click Properties...
In Dz click Custom
In the first row Fraction box type 0.999 and in the Cells box type 1 (Figure 1)
In the second row Fraction box type 0.001 and in the Cells box type 1 (Figure 1)
Click OK to save changes to the default layer

Figure 1: Input of cell sizes
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If you close and reopen the Edit Layers dialog, you will notice that Dz has been changed to a Regular
mesh with a Factor of 1.001E-03. This is an alternate way to describe the same sizes for two elements.

Generate the Mesh
We now need to generate the mesh:
1.
2.
3.
4.
5.

On the Model menu, click Create Mesh
For Mesh Type, select Regular
In the X Cells box, type 1
In the Y Cells box, type 1
Click OK to create the mesh

Material Properties
The large model cell uses the default material properties. However, for the temperature boundary
condition cell, we want only heat to flow into or out of the cell, not any fluid. This can be accomplished
by making a special material that has zero permeability. In addition, we specify a small porosity so that
we can use the solid properties for our heat capacity calculations and neglect the heat capacity of the
small amount of fluid in the cell.
To make a new material to use in applying the temperature boundary conditions:
1.
2.
3.
4.

On the Properties menu, click Edit Materials...
In the Material Data dialog, click New
In the Name box, type TEMP
Click OK to create the new material, by default, the new material data will be based on
theROCK1 data
5. For the TEMP material, change the value in the Porosity box to 0.001.
6. For the TEMP material, in all three Permeability boxes (X, Y, and Z), type 0.0. There will be no
flow into the cell.
Click OK to save changes and exit the Edit Materials dialog.

Define Temperature Boundary Condition in Thin Cell
To modify the thin cell so that it defines a temperature boundary condition:
1.
2.
3.
4.

Spin the model and click on the top. This should select only the thin cell.
Right-click and select Edit Cells…
In the Cell Name box, type TempBC
In the Vol. Factor box, type 1.0E20 (the volume of the cell will be the actual volume, 1, times the
factor, for a volume of 1.0E20 m3.
5. In the Material list, select TEMP (we want to use the special boundary condition material)
We will return to define sources /sinks in the extra cell. We use the default initial conditions in the
boundary condition cell. To turn on detailed printing of time history data:
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1. Click the Print Options tab
2. Click to select both print options.

Heat Flow into Boundary Condition Cell
We have now created a boundary condition cell that has a volume of 1.0E20 m3, a density of 2600
kg/m3, a porosity of 0.001, and a specific heat of 1000 J/kg-C. For this example, we will specify a
sinusoidal temperature history with an average of 100 ˚C, an amplitude of 50 ˚C, and a period of 30 days,
Figure 2.

Figure 2: Desired boundary condition temperature history
We calculate the heat flow as follows:
̇
where ̇ is the heat flow, is the cell volume, is the rock density, is the rock heat capacity,
is
the change in temperature, and is the change in time. Note that since the porosity is very small, we
only use the rock properties and apply this to the entire cell volume. The calculated heat flows to obtain
the desired temperature time history are shown in Table 1.
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Table 1: Calculated heat flow to change boundary cell to desired temperature
Time
Day
0
1
2
3
4
5
6
7
8
9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30

Sec
0
86400
172800
259200
345600
432000
518400
604800
691200
777600
864000
950400
1036800
1123200
1209600
1296000
1382400
1468800
1555200
1641600
1728000
1814400
1900800
1987200
2073600
2160000
2246400
2332800
2419200
2505600
2592000

Temp
(C)
100
110.3956
120.3368
129.3893
137.1572
143.3013
147.5528
149.7261
149.7261
147.5528
143.3013
137.1572
129.3893
120.3368
110.3956
100
89.60442
79.66317
70.61074
62.84276
56.69873
52.44717
50.27391
50.27391
52.44717
56.69873
62.84276
70.61074
79.66317
89.60442
100

Heat Flow
3.12830090E+22
2.99157914E+22
2.72411102E+22
2.33758617E+22
1.84889759E+22
1.27940331E+22
6.53992972E+21
0.00000000E+00
-6.53992972E+21
-1.27940331E+22
-1.84889759E+22
-2.33758617E+22
-2.72411102E+22
-2.99157914E+22
-3.12830090E+22
-3.12830090E+22
-2.99157914E+22
-2.72411102E+22
-2.33758617E+22
-1.84889759E+22
-1.27940331E+22
-6.53992972E+21
0.00000000E+00
6.53992972E+21
1.27940331E+22
1.84889759E+22
2.33758617E+22
2.72411102E+22
2.99157914E+22
3.12830090E+22
1.00308642E+22

To specify this heat flow into the boundary cell:
1.
2.
3.
4.
5.
6.

Double-click the thin top cell to edit it.
Click the Sources/Sinks tab
Click Heat In
In the options list, select Table
Click the Edit button and type (or paste) the values shown Table 1
Click OK to save changes and exit the Heat Rates dialog

Click OK to save changes and exit the Edit Cell Data dialog.
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Initial Conditions
The initial conditions for the model should be a single phase temperature of 100 ˚C and a pressure of
1.0E6 Pa.

Edit Solution Controls
Parameters relating to the solver and time stepping can be found in the Solution Controls dialog.
To specify the simulation end time:
1.
2.
3.
4.
5.

On the Analysis menu, click Solution Controls
In the End Time list, click User Defined and type 30 days
In the Max Time Step list, click User Defined and type 1 days
Click the Weighting tab
For Permeability at Interface list, click Harmonic Weighted. This will ensure that the
permeability at the interface for fluid flow into and out of the boundary will be zero (see the
PetraSim user manual and the TOUGH2 user manual for a supporting discussion)
6. Click the Options tab
7. For Boundary condition Interpolation, click Rigorous Step
8. Click OK

Edit Output Controls
By default, the simulation will print output every 100 time steps. For this simulation, we will specify
output every time step.
To specify the output frequency:
1. On the Analysis menu, click Output Controls
2. In the Print and Plot Every # Steps box, type 1
3. Click OK

Save and Run
The input is complete and you can run the simulation.

View Time History Plots
To view time history plots:
1.
2.
3.
4.
5.

On the PetraSim Results menu, click Cell History Plots
In the Variable list, click T (deg C)
In the Cell Name list, click TempBC
In the Cell Time History window, on the File menu, click Export Data… and save the data.
You can then import the data and compare the calculated boundary condition temperatures to
the desired values, as shown in Figure 3.
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6. In the Cell Name list, click Cell 1 (the large cell) to view the time history of the temperature in
the model cell. This response shows a temperature change from 100 ˚C to a maximum of
100.5983 ˚C, Figure 4. A hand calculation gives an analytic value of 100.597 ˚C.

Figure 3: Comparison of calculated and desired boundary condition cell temperatures

Figure 4: Time history response of model cell
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When finished, you can close the Cell History dialog.
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Boundary Condition using Thin Cell and Polygonal Mesh
We now repeat the specifying a temperature boundary condition, but using a polygonal mesh.
1. Open the previous model
2. Save the model under a different name.
We have already defined the spacing for the thin cell, so that does not need to be modified.
To regenerate the mesh:
1. On the Model menu, click Create Mesh
2. For Mesh Type, select Polygonal
3. Click OK to create the mesh
We now set the boundary conditions for the top layer. To calculate and set the boundary conditions in
the top lower left polygonal cell:
1. Click the Select Mesh Layer tool, then select the top thin layer. This will select all the cells in that
layer, Figure 5.

Figure 5: Select all cells in the top layer
2. On the Edit menu, click Properties...
3. In the Vol. Factor box, type 1E20 (the entire top layer will have the same volume as the previous
example)
4. In the Material list, select TEMP (we want to use the special boundary condition material)
5. Click the Sources/Sinks tab
6. Click Heat In
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7. In the options list, select Table Flux and input the values shown in Table 2. This is the same
information as in Table 1, but the heat flow has been divided by the XY area (100 m2) to give the
flux.
8. Click OK
Table 2: Specification of heat flow using flux

Time
0
86400
172800
259200
345600
432000
518400
604800
691200
777600
864000
950400
1036800
1123200
1209600
1296000
1382400
1468800
1555200
1641600
1728000
1814400
1900800
1987200
2073600
2160000
2246400
2332800
2419200
2505600
2592000

Flux
3.12830000E+20
2.99158000E+20
2.72411000E+20
2.33759000E+20
1.84890000E+20
1.27940000E+20
6.53993000E+19
0.00000000E+00
-6.53993000E+19
-1.27940000E+20
-1.84890000E+20
-2.33759000E+20
-2.72411000E+20
-2.99158000E+20
-3.12830000E+20
-3.12830000E+20
-2.99158000E+20
-2.72411000E+20
-2.33759000E+20
-1.84890000E+20
-1.27940000E+20
-6.53993000E+19
0.00000000E+00
6.53993000E+19
1.27940000E+20
1.84890000E+20
2.33759000E+20
2.72411000E+20
2.99158000E+20
3.12830000E+20
1.00309000E+20

Select at least one cell in the thin layer and on in the thick layer to print time history data.
Run the analysis and essentially the same results will be obtained in the model cells.
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Summary
This has illustrated how to apply temperature-only boundary conditions in a PetraSim/TOUGH2 model.
Other combinations of boundary conditions are discussed in the PetraSim User Manual. The principles
are the same.
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